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Chapter 1: Introduction and Setup
1.1 Introducing the TCP/IP PLC Simulator
TCP/IP PLC Simulator is a software PLC which can be used to simulate a real PLC and test configurations.
The soft PLC works together with the Generic TCP/IP driver - ID 34.
The soft PLC has the following features:
l

can send and receive values, arrays and strings to and from IGSS

l

can send and receive alarm bits

l

supports four different data modes - BYTE, WORD, DWORD and FLOAT

l

supports up to 8 nodes

l

simulates a real PLC allowing you to get real driver alarms

The soft PLC looks like this. In this case, the user has double-clicked on Word number 0 to send a value to
IGSS.

For a live example using TCP/IP PLC Simulator, watch this video:

IGSS OPC Client and Server
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1.2 Activating the Generic TCP/IP driver
Before you can make use of the IGSS Soft PLC, you must activate the Generic TCP/IP driver, ID 34.

1. Open the System Configuration module.
2. Select the station from which you will be using the soft PLC.
3. Click the Add Driver icon in the toolbar or right-click the station and select New Driver.
4. Click the header of the ID column to sort by ID. Scroll down to find ID 34.
5. Double-click the driver as shown below.

6. Click the + sign beside the driver name and select the interface icon named 7TTCP. Right-click
and select New Node.
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7. By default, a node is set up to be running on the local host. This can be changed to a remote IP
address, if required.

8. If required, you can add as many as 8 nodes. The soft PLC supports up to 8 nodes.
9. The driver is now activated and ready to run with IGSS Soft PLC. Make sure that Run Simulated is not selected on the Data Collection tab.
10. In the File menu, select Save and Exit.
11. Continue with the topic: Auto-starting the IGSS Soft PLC.htm

1.3 Auto-starting the PLC Simulator
When you are using the PLC Simulator, you may want to auto-start it every time you start the IGSS configuration. Do the following:

1. Open Windows Explorer.
2. Navigate to the folder containing the current IGSS configuration.
3. Create a subfolder named Startup.
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4. In this folder, create a shortcut to the PLC Simulator executable:

[IGSS InstallPath]\Gss\7TTCPMON.exe

5. Assign a name to the shortcut, for example, Soft PLC.

IGSS will automatically activate all shortcuts located in the Startup folder when you start this configuration.

If you need to manually start the PLC Simulator, go to the Runtime and
Diagnostics Tab in the IGSS Master and click the TCP /IP Simulator
button

-4-

IGSS V10, User Guide

Chapter 2: Functionality
2.1 DBInput
In DBInput you can either choose hexadecimal or decimal as the basis. The type can either be a number,
an array or a string.

2.2 Sending an array
1. Make a test object in IGSS, for example a table object with three values, "Address type" WORD
and offset 1. Choose 7TTCP as driver on the Edit Mapping tab.
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2. Double click element number 2 in TCP/IP PLC Simulator and enter the value "1". Click Ok
NoSend.
3. Double-click element number 3, enter "2" and Ok NoSend.
4. Double-click element number 4, enter "3" and Ok NoSend. Choose element number 2, choose
"Array" and enter "3". Click Ok Send. Your table object should now show 1, 2 and 3.

2.3 Sending a number
1. Make a test object in IGSS, for example of the type Analog, and choose 7TTCP as driver on the
Edit Mapping tab.
2. Choose Data type Word and Offset 0. As default, the values in TCP/IP PLC Simulator are sent
to the object and hence there is no need to scan it.
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3. Double click index 0 in TCP/IP PLC Simulator. A dialogue, DBInput, appears. Set DB value to
1 and click OK Send. Your test object should show 1.

-7-

IGSS V10, User Guide

2.4 Sending a string
1. Make a new test object in IGSS of the type "String" with Data type WORD and Offset 2.
2. Choose 7TTCP as driver on the Edit Mapping tab.

3. Double- click element number 3 in TCP/IP PLC Simulator, choose String as type and enter
"Test". Click Ok Send. Your object in IGSS should show "Test".

2.5 Scan / event
As default TCP/IP PLC Simulator is event driven and the objects do not need to be scanned. If you want to
test the scanning of objects, this must first be chosen in IGSS.

1. Right- click an object, click the Data Management Definitions tab. For example, choose a
Scan interval of 2000 msec.
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2. In TCP/IP PLC Simulator, double-click an element belonging to the object, which should be
scanned. Choose a type and enter a value. Click "Ok NoSend" to send it to TCP/IP PLC Simulatordatabase. IGSS will scan the object for changes and copy the value to the object.

2.6 OnTop
This option can be used to maintain the Tcpmon window On Top of IGSS while testing.
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Chapter 3: Reference and Lookup
3.1 Conventions in this Manual
The following typographical conventions are used:

Convention

Description

Example

User interface element

When referring to labels and names
in the user interface.

User input

When the user has to type specific
data in IGSS

The Data Management tab.

Type the following description:

Incoming flow in Tank 2

Module
name

When referring to a module in IGSS

Note

A note emphasizes or supplements
important points of the main text. A
note provides information that may
apply only in special cases.

Tip

A tip suggests alternative methods
that may not be obvious in the user
interface. A tip also helps the user in
working more effectively with IGSS.
A tip is not essential to the basic
understanding of the text.

Alternative to this simple find
function, you can also filter on
text in the messages in Driver
Log Filters dialog box.

Warning

A warning is an important note that is
essential for the completion of a
task. In some cases, disregarding a
warning may result in undesirable
functionality or loss of data.

If you disregard the System
alarm, you may risk loss of
data in the LOG and BCL files.

Open the Definition module.

By default, the timestamp is in universal time
format, UTC1. This can be changed in the
Driver Log Filters dialog box.

3.2 Getting Help in IGSS
IGSS comes with a comprehensive help system designed to help both system designers and operators to
get started with IGSS as quickly as possible.

Documentation overview
The IGSS documentation includes the following items:

1 Universal Time Coordinated (formerly Greenwich Mean Time), used as the basis for calculating time in

most parts of the world. IGSS uses this time format internally in the database. You can switch between UTC
and local time by enabling or disabling the "UTC" field in various dialog boxes in the system.
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Documentation item

Description

Getting Started

An introduction to IGSS and its most fundamental terms and features.
Getting Started is intended to get you up and running as fast as possible. The manual provides a system and architecture overview followed by a number of real-life use cases you can go through before
building your first real IGSS project. The manual is available in Adobe
Acrobat format (.pdf).
For each module there is a help file with the same name as the module
itself, for example, Def.chm for the Definition module.

Module help

The help file is invoked by clicking the
in the upper right corner of
the module. The Table of Contents will then allow you to browse
through the topics.
For each Form or dialog there is a help topic with the following standard information:

Form and Dialog help

l

Overview

l

Preconditions

l

Where do I find it?

l

Field help

Form help is invoked by clicking the help button
in the upper right
hand corner of the dialog box or located in the Table of Contents of the
individual help file.
IGSS also provides thematic help. When there is a special theme that
requires special attention from the user, a dedicated help file is provided. Examples include "Driver-Specific Help" and "Database Administration Help".

Thematic help

Where are the help files located?
The IGSS help files are located in the appropriate language folder in the installation path of IGSS, by
default C:\Program Files\Schneider Electric\IGSS32\V10.0. The help files are available in English at
release time.
The paths to the help files are:

Language

Path

English

[IGSS InstallPath]\ENG

Danish

[IGSS InstallPath]\DAN

German

[IGSS InstallPath]\DEU

Translated help files
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Selected help files have been translated into Danish and German. If you require help files in your language,
please contact 7-Technologies A/S.

Help updates
The help files are continuously updated and improved. Check regularly with the IGSS Update in the IGSS
Master.

3.3 Version Information (IGSS Help System)
© 7-Technologies A/S, IGSS Version 10.0
The IGSS help files are based on software build number 10305 (initial release)

English help files
To update the help files, click the Update IGSS Software button on the Information and Support tab
in the IGSS Master . There must be a connection from the PC to the Internet. Every time IGSS Update is
run, IGSS help files as well as IGSS system files will automatically be updated on the PC from the web
server at 7-Technologies A/S.
You select the languages you want to update in the Tools menu of the IGSS Update form.
If you are not able to update the IGSS system directly via the Internet, the alternative is to download the
updates from the 7-Technologies A/S website as zip files. These can then be transferred onto a CD or USB
memory stick, which is then the medium used to update on site.

After updating your IGSS installation , the build numbers in various IGSS modules may change to a
higher number. This signifies that the module in question has been updated with newer files. Build
numbers consist of four digits, where the first digit represents the year and the last three represent
the day number in the year in question. The build number can be seen in the About dialog box which
can be activated from the Help menu.
An example:

Build number = 10305
12 = the year 2012
305 = The 305th day of the year
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Chapter 4: Glossary
A
Application menu
The Application menu is the first ribbon in the IGSS Master module. Click the icon to drop down
the menu. The menu contains items that were typically found in the File menu in previous versions of IGSS. In most modules, an "Options" item allows the user to define global module settings. The Application menu was introduced in the Microsoft Office 2010 package. It replaces the
Application button (nicknamed Doughnut) which was introduced in IGSS V7 and V8.

D
descriptor
A descriptor is the graphical display of an object. IGSS includes many types of descriptors including: - Built-in standard symbols - Animated symbols (Symbol Factory library) - Graphics and
animation - Drawing symbols - Windows controls - ActiveX controls An IGSS object can be represented with different descriptors on different diagrams.

Q
Quick Access Bar
You can customize the Quick Access Bar to include the functions you use most frequently. Simply
drag the relevant function from the ribbon to the Quick Access Bar.

R
Ribbon
The Ribbon is a new term/element in the Microsoft universe. The Ribbon replaces the well-known
toolbars in applications. The Ribbon provides quick access to the most commonly used functions
in the application. The Ribbon is divided into logical groups (the tabs) and each tab is divided into
sections (the blocks in the tab). The Ribbon is context-sensitive which means that only relevant
functions are accessible dependent on the current user action.

S
SCADA
Supervisory Control & Data Acquisition

U
UTC
Universal Time Coordinated (formerly Greenwich Mean Time), used as the basis for calculating
time in most parts of the world. IGSS uses this time format internally in the database. You can
switch between UTC and local time by enabling or disabling the "UTC" field in various dialog boxes
in the system.
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